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Chapter 1. Overview of IBM Sterling Business Intelligence

IBM® Sterling Business Intelligence is an analytical solution that can be used by
users of this application to aggregate the data that is available across supply chain
products of IBM and generate performance reports relevant to their business.

This document contains instructions for installing the various components of the
Sterling Business Intelligence application. It also describes the components of the
Sterling Business Intelligence application, and provides information about how to
set these up in a typical implementation.

Intended Audience
This document provides installation and administration information for individuals
who are responsible for installing and maintaining the Sterling Business
Intelligence application.

This document assumes that the users of Sterling Business Intelligence have
working knowledge about installing the IBM Cognos 8 Business Intelligence,
Version 8.4.1, suite of products as well as the IBM Sterling Selling and Fulfillment
Foundation. Therefore, it is recommended that you read the related Cognos®

documentation and the documentation before attempting to install the Sterling
Business Intelligence application.

Conventions
In this manual, Windows refers to all the supported Windows operating systems.

The following conventions may be used in this manual:

Convention
Meaning

<AC_INSTALL_DIR>

User-supplied location of the Sterling Business Intelligence Analytics
Content installation directory.

<INSTALL_DIR>

User-supplied location of the Sterling Selling and Fulfillment Foundation
installation directory. This is only applicable for Release 9.1.

<BI_COGNOS8_HOME>

User-supplied location of the IBM Cognos 8 Business Intelligence Content
installation directory.

<c8_installation>

User-supplied location of the IBM Cognos 8 Business Intelligence
installation directory. This is only applicable for Version 8.4.1.

© Copyright IBM Corp. 2009, 2011 1
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Chapter 2. Prerequisites for Installing IBM Sterling Business
Center

Following are the prerequisites for installing Sterling Business Intelligence:
v Successful installation and configuration of Sterling Selling and Fulfillment

Foundation, Release 9.1. For more information about installing and configuring
Sterling Selling and Fulfillment Foundation, refer to the Selling and Fulfillment
Foundation: Installation Guide.

v Successful installation and configuration of Cognos 8 Business Intelligence,
Version 8.4.1. For more information about installing and configuring Cognos 8
Business Intelligence, Version 8.4.1, refer to the Cognos 8 Business Intelligence
Installation and Configuration Guide, which is available in the Cognos
installation CD.
Note: The 64-bit version of Cognos 8 Business Intelligence, Version 8.4.1, is not
compatible with the Cognos 8 Analytic Applications. You must, therefore, install
the 32-bit version of Cognos 8 Business Intelligence, Version 8.4.1.

v You must ensure that the database schema is created and configured for both the
Sterling Staging Database and the Sterling Data Mart Database. For more
information about configuration settings for the data warehouse database, refer
to the Cognos 8 Analytic Applications Adaptive Warehouse User Guide at
http://publib.boulder.ibm.com/infocenter/caapps/v8r4m0/index.jsp?topic=/
com.ibm.swg.im.cognos.ug_aw.8.4.2.doc/ug_aw.html.
After the database is set up, you must have the following information pertaining
to both the Sterling Staging Database and Sterling Data Mart Database:
– Database user name and password
– Database host name and port
– Database catalog name

© Copyright IBM Corp. 2009, 2011 3
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Chapter 3. Checklist for IBM Sterling Business Intelligence
Installation

Use the following checklist to guide you through the Sterling Business Intelligence
installation tasks:
1. Ensure that you have the necessary prerequisites to install and run the Sterling

Business Intelligence solution as listed in the topic Chapter 2, “Prerequisites for
Installing IBM Sterling Business Center,” on page 3

2. Ensure that you have understood the Sterling Business Intelligence ecosystem
and the necessary system requirements to install and run the Sterling Business
Intelligence application as described in the topic Chapter 4, “Understanding the
IBM Sterling Business Intelligence Ecosystem,” on page 7. It is recommended
that you use the same vendor for the platform and the database, that you used
for the Sterling Transaction System (server 1) and the Sterling Source Database
(server 2) respectively.

3. Install the Sterling Business Intelligence Application component. For more
information about this, refer to the topic Chapter 5, “Installing the IBM Sterling
Business Intelligence Application,” on page 13.

4. Install the Sterling Business Intelligence Adaptive Applications Framework. For
more information about this, refer to the topic “Install the IBM Sterling
Business Intelligence Adaptive Applications Framework” on page 21.

5. Install the Sterling Business Intelligence Analytics Content component. For
more information about this, refer to the topic “Install the IBM Sterling
Business Intelligence Analytics Content” on page 27.

6. Install the Sterling Business Intelligence Adaptive Applications Runtime
component. For more information about this, refer to the topic Chapter 7,
“Install the IBM Sterling Business Intelligence Adaptive Applications Runtime
in Windows Environment,” on page 23.

7. Install the Sterling Business Intelligence Analytics Content for IBM Cognos 8
Business Intelligence. For more information about this, refer to the topic “Install
the IBM Sterling Business Intelligence Content for IBM Cognos 8 Business
Intelligence” on page 29.

8. Deploy the Sterling Business Intelligence Application components. For more
information about this, refer to the topic Chapter 11, “Deploy IBM Sterling
Business Intelligence,” on page 31.

9. Verify the Sterling Business Intelligence installation. For more information
about this, refer to the topic Chapter 12, “Verify the IBM Sterling Business
Intelligence Installation,” on page 43.

© Copyright IBM Corp. 2009, 2011 5
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Chapter 4. Understanding the IBM Sterling Business
Intelligence Ecosystem

This topic explains the Sterling Business Intelligence application ecosystem, which
is illustrated here.

Important: The best distribution option of installing the Sterling Business
Intelligence components depends on your individual requirements, resources, and
preferences. It is strongly recommended that you install each of the components on
different servers.

IBM Sterling Business Intelligence Application
The Sterling Business Intelligence application is installed on Sterling Selling and
Fulfillment Foundation. The Sterling Business Intelligence application is installed
on server 1. The application consists of a Web User Interface (UI) and related APIs'
that help you select the reports criteria and generate reports. The application also
installs framework components related to efficient change data capture, and other
configuration data essential for the application to work.

Sterling Source Database
The Sterling Source Database hosts the online transaction processing (OLTP)
database server, which is installed on server 2. This is used as a source data server.
The technical stack requirements for this system are the same as that required for a
database server in Sterling Selling and Fulfillment Foundation. For more
information about the technical stack requirements for this system, refer to the
Selling and Fulfillment Foundation: System Requirements Guide.

© Copyright IBM Corp. 2009, 2011 7



Sterling Staging Database
The Sterling Staging Database is the source for the data mart database, and is
installed on server 3. The staging environment consists of a database in which the
incremental transaction data that is extracted, transformed, and loaded (ETL) from
the source is stored. For information about the technical stack requirements for this
system, refer to the Selling and Fulfillment Foundation: System Requirements Guide.

IBM Cognos 8 Business Intelligence Server
The Cognos 8 Business Intelligence server is the environment in which the Cognos
8 Business Intelligence server is hosted. This is installed in server 4. For
information about the technical stack requirements for the Cognos 8 Business
Intelligence server, refer to the Cognos 8 Analytics Applications Installation and
Configuration Guide.

IBM Sterling Business Intelligence Adaptive Applications Framework
The Sterling Business Intelligence Adaptive Applications Framework component
includes the IBM Cognos Adaptive Applications Framework. This component is
installed on server 5.

The IBM Cognos Adaptive Applications Framework includes:
v Adaptive Warehouse
v Adaptive Analytics

Adaptive Warehouse is a data modeling environment used to design and populate
a target data warehouse. It provides an interface that facilitates the extraction,
transformation, and loading of application-specific data from the source database
into the target data warehouse. It helps you construct a source model that
describes the rules for querying the source database.

Adaptive Analytics provides a set of reports for performance monitoring, analysis,
and operational reporting. These role-based report layouts allow you to quickly
analyze the data in your warehouse in the context of each application.

For more information about installing the Sterling Business Intelligence Adaptive
Applications Framework component, refer to the topic “Install the IBM Sterling
Business Intelligence Adaptive Applications Framework” on page 21.

Introduction to Installing the IBM Sterling Business Intelligence
Analytics Content

Prior to installing the Sterling Business Intelligence Analytics Content, ensure that
JDK1.5 or later version is installed in the system.

The Sterling Business Intelligence Analytics Content component is available only
for Microsoft Windows. This installer installs the application content files in your
system.

The Sterling Business Intelligence Analytics Content is installed on server 5, as
described in the topic Chapter 4, “Understanding the IBM Sterling Business
Intelligence Ecosystem,” on page 7.

Note: Ensure that there is at least 50 MB of free space available for installation.
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IBM Sterling Business Intelligence Analytics Content
The Sterling Business Intelligence Analytics Content component consists of
Analytics content files for your system. Analytics content files are metadata files
that serve as the data mart model as well as the report specification. This
component is installed on server 5.

For more information about installing the Sterling Business Intelligence Adaptive
Analytics Content component, refer to the topic “Install the IBM Sterling Business
Intelligence Analytics Content” on page 27.

IBM Sterling Business Intelligence Adaptive Applications Runtime
The Sterling Business Intelligence Adaptive Applications Runtime component
consists of the IBM Cognos Adaptive Warehouse Runtime. This component is used
by the Adaptive Warehouse user interface and scripts. The Sterling Business
Intelligence Adaptive Applications Runtime helps to run the extract, transform,
and load (ETL) scripts in different environments. The Sterling Business Intelligence
Adaptive Applications Runtime component is installed on server 6.

For more information about installing the Sterling Business Intelligence Analytics
Applications Runtime component, refer to the topic Chapter 7, “Install the IBM
Sterling Business Intelligence Adaptive Applications Runtime in Windows
Environment,” on page 23.

IBM Sterling Business Intelligence Components and Content for IBM
Cognos 8 Business Intelligence

The Cognos 8 Business Intelligence Content comprises dashboard reports and files
required for communication between the Cognos Business Intelligence server and
the Sterling Business Intelligence application. This component is installed on server
7.

For more information about installing the Cognos 8 Business Intelligence Content
component, refer to the topic “Install the IBM Sterling Business Intelligence
Content for IBM Cognos 8 Business Intelligence” on page 29.

Sterling Data Mart Database
The Sterling Data Mart database is the environment in which the data mart
database is hosted. This is installed on server 8. The data in this database is
dimensionally modeled data that is analytics-friendly. For information about the
technical stack requirements for this system, refer to the Selling and Fulfillment
Foundation: Installation Guide.
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Supported Stacks
The following table describes the stacks that are supported by Sterling Business
Intelligence:

Component
Application
Server

DB
Version OS Version JDK Version

Sterling
Business
Intelligence
Application

Oracle
WebLogic
11gR1
(10.3.2)

v HP-UX 11i v3 on Itanium

v IBM AIX® 6.1 SP10

v Sun Solaris 10 on SPARC
processor and AMD
Opteron

v Red Hat Enterprise Linux
5.5 / AP 64-bit Xeon or
AMD processor

v SUSE Linux Enterprise 11
on 64-bit Xeon or
AMD-Opteron processor

v Windows 2008 Enterprise
/ Standard Edition

v HP JDK 6.0.02
(64-bit)

v IBM JDK 6.0
(64-bit)

v Sun JDK 6.0
Update14
(1.6.0_14) (64-bit)

v JRockit 6.0
(R27.6.0-50) (64-bit)

v Sun JDK 6.0
Update14 or
JRockit 6.0
(R27.6.0-50) (64-bit)

v Sun JDK 6.0
Update14 or
JRockit 6.0
(R27.6.0-50) (64-bit)
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Component
Application
Server

DB
Version OS Version JDK Version

Sterling
Business
Intelligence
Application

IBM
WebSphere®

7.0.0.9

v IBM AIX 6.1 SP10

v Sun Solaris 10 on SPARC
processor and AMD
Opteron

v Red Hat Enterprise Linux
5.5 / AP 64-bit Xeon or
AMD processor

v SUSE Linux Enterprise 11
on 64-bit Xeon or
AMD-Opteron processor

v IBM JDK 6.0 SR7
(WebSphere7.0.0.9)

v IBM JDK 6.0 SR7
(WebSphere7.0.0.9)

v Sun JDK 6.0
Update14
(1.6.0_14) (64-bit)

v Sun JDK 6.0
Update14
(1.6.0_14) (64-bit)

JBoss EAP
4.3

v Red Hat Enterprise Linux
5.4 / AP 64-bit Xeon or
AMD processor

v Sun Solaris 10 on SPARC
processor and AMD
Opteron

v Sun JDK 6.0
Update 14
(1.6.0_14) (64-bit)

v Sun JDK 6.0
Update 14
(1.6.0_14) (64-bit)

Oracle
11.1.0.7

v HP-UX 11i v3 on Itanium

v IBM AIX 6.1 SP10

v Sun Solaris 10 on SPARC
processor and AMD
Opteron

v Red Hat Enterprise Linux
5.5 / AP 64-bit Xeon or
AMD processor

v SUSE Linux Enterprise 11
on 64-bit Xeon or
AMD-Opteron processor

v Windows 2008 Enterprise
/ Standard Edition

DB2® 9.7 v IBM AIX 6.1 only with
WebSphere and
WebLogic 10.3.2

v Red Hat Enterprise Linux
5.5 / AP 64-bit Xeon or
AMD processor only
with WebSphere and
WebLogic

Microsoft
SQL 2005
SP2

v Windows 2008 Enterprise
/ Standard Edition

Sterling
Business
Intelligence
Adaptive
Applications
Framework

NA NA Microsoft Windows (32-bit) NA
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Component
Application
Server

DB
Version OS Version JDK Version

Sterling
Business
Intelligence
Adaptive
Applications
Runtime

NA NA v Microsoft Windows
(32-bit)

v IBM AIX 6.1

v Sun Solaris 10 on SPARC
processor

v Red Hat Enterprise Linux
Server 5 (x86-64)

v Windows 2008 Enterprise
/ Standard Edition

NA

Note: It is recommended that you avoid using Sterling Business Intelligence
Adaptive Applications Runtime on Sun Solaris 10, UltraSPARC T1 and T2
processors as it is known to have performance issues.

Internet Browser and Plug-In Requirements
The following table describes the Internet browser and Java plug-in requirements:

Internet Browser Operating System JRE

v Microsoft Internet Explorer
8

v Microsoft Internet Explorer
7

v Mozilla Firefox 3.6

v Mozilla Firefox 3.5

All operating systems NA

Note: While using MS Internet Explorer 8, it is recommended that you turn off the
Compatibility View option.

Third-Party Software Requirements
The following table describes the third-party software requirement for Sterling
Business Intelligence:

Third-Party Software Version

Cognos 8 Business
Intelligence

8.4.1 For information about the Cognos 8 BI Version
8.4.1 software environments, see:

http://www-01.ibm.com/support/
docview.wss?uid=swg27017522
http://www-01.ibm.com/support/
docview.wss?uid=swg27017522

12 Sterling Business Intelligence: Installation Guide

http://www-01.ibm.com/support/docview.wss?uid=swg27017522
http://www-01.ibm.com/support/docview.wss?uid=swg27017522
http://www-01.ibm.com/support/docview.wss?uid=swg27017522
http://www-01.ibm.com/support/docview.wss?uid=swg27017522


Chapter 5. Installing the IBM Sterling Business Intelligence
Application

Prior to installing the Sterling Business Intelligence application, ensure that you
have installed Sterling Selling and Fulfillment Foundation, Release 9.1. You must
also ensure that the database schema is created and configured for both the
Sterling Staging Database and the Sterling Data Mart Database. For more
information about the configuration settings for the data warehouse database, refer
to the Cognos 8 Analytic Applications Adaptive Warehouse User Guide.

The Sterling Business Intelligence application should be installed on server 1, as
described in the topic Chapter 4, “Understanding the IBM Sterling Business
Intelligence Ecosystem,” on page 7.

Note: You will be directed to perform either a single schema installation or a
multischema installation based on the configuration of Sterling Selling and
Fulfillment Foundation, Release 9.1.

Ensure that there is at least 1 GB of free space available for installation.

Single Schema Installation in Windows
To perform a single schema installation in a Windows environment, perform these
steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Business_Intelligence_Application

folder.
3. Copy SCIInstallWizard.jar and sbi.jar to your designated path, for example,

D:/sbi/CDROM/SCIINSTALLWizard.jar.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

The Installation dialog box is displayed.

Note: You must be in the directory in which the SCIInstallWizard.jar file
resides when executing this command.

5. Click Next to start the installation. The License Conditions screen is displayed.
6. Review the license agreement and click Accept to accept the terms.
7. In the Sterling Selling and Fulfillment Foundation Folder screen, enter the

path to the folder in which Sterling Selling and Fulfillment Foundation,
Release 9.1, is installed. Alternatively, click Select Folder and navigate to the
location in which Sterling Selling and Fulfillment Foundation, Release 9.1, is
installed, and click Select Folder. This displays the folder's path in the Selling
and Fulfillment Foundation Folder screen.

8. Click Next.
9. In the Confirming Input Information screen that is displayed, verify that you

have selected the correct folder, and click Next. (To select another folder, click
Back and repeat steps 6, 7, and 8).

© Copyright IBM Corp. 2009, 2011 13



The Data Mart Database Connection Information screen is displayed, with the
Database Vendor name populated in the corresponding field.

10. Enter the relevant information in the applicable fields for Sterling data mart
database, as described in the following table.

Note: Determine and record information about your Oracle, Microsoft SQL
server 2005, or DB2 database server on which the schema for the Sterling data
mart database is created. Ensure that the schema is created with the UTF-8
character set enabled. For more details about enabling the UTF-8 character set,
refer to the documentation pertaining to the corresponding database.

Field Description

Database user name

Name of the database user.

Database password

Password to access the database.

Confirm database password

Re-enter the password.

Database catalog name

Name of the database catalog, for example, OracleSID.

Database schema name

Name of the database schema. This field is optional. If no value is
entered, for DB2 and Oracle database, the default value for the
schema name is the same as the user name. For Microsoft SQL server,
the default value for the schema name is dbo.

Database host name

IP address or host name of the location in which the database is
installed.

Database port

Port number of the database.

JDBC driver file

Path to the database driver file, for example, D:/sbi/ojdbc14.jar

Note: If your database is DB2, enter your second JDBC driver file path
also.

11. Enter the relevant information in the applicable fields for Sterling staging
database, as described in the following table.

Note: Determine and record information about your Oracle, Microsoft SQL
server 2000/2005, or DB2 database server on which the schema for the Sterling
staging database is created. Ensure that the schema is created with the UTF-8
character set enabled. For more details about enabling the UTF-8 character set,
refer to the documentation pertaining to the corresponding database.

Field Description

Database user name

Name of the database user.
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Database password

Password to access the database.

Confirm database password

Re-enter the password.

Database catalog name

Name of the database catalog, for example, OracleSID.

Database schema name

Name of the database schema. This field is optional. If no value is
entered, for DB2 and Oracle database, the default value for the schema
name is the same as the user name. For Microsoft SQL server, the
default value for the schema name is dbo.

Database host name

IP address or host name of the location in which the database is
installed.

Database port

Port number of the database.
12. Click Next.
13. In the Installation Progress screen that is displayed, click Install to proceed

with the installation. To view detailed information about the progress of the
installation, click Show Details.

14. After the installation is completed, click Exit. For details about errors that may
have occurred during installation, refer to the SBI_PreInstallSI.log file available
in the <INSTALL_DIR> directory

15. Install the database DDLs by executing the dbverify utility to verify the
database schema.

16. Load the factory setup. To load the Sterling Business Intelligence database
factory defaults after the product installation, load the defaults using the
script applicable to your operating system. From the command line, run the
<INSTALL_DIR>/bin/loadDefaults.sh command on UNIX or Linux, and the
<INSTALL_DIR>\bin\loadDefaults.cmd command on Windows, and pass the
absolute file path to the installer XML file, and the absolute path to the factory
setup XMLs:
v On UNIX or Linux:

loadDefaults.sh

<INSTALL_DIR>/installed_data/sbi/factorysetup/installer.xml

<INSTALL_DIR>/installed_data/sbi/factorysetup/XMLS

v On Windows:
loadDefaults.cmd

<INSTALL_DIR>\installed_data\sbi\factorysetup\installer.xml

<INSTALL_DIR>\installed_data\sbi\factorysetup\XMLS

Single Schema Installation in UNIX
To perform a single schema installation in UNIX environment, perform these steps:
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Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Business_Intelligence_Application

folder.
3. Copy SCIInstallWizard.jar and sbi.jar to your designated path, for

example, D:/sbi/CDROM/SCIINSTALLWizard.jar.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

Note: You must be in the directory in which the SCIInstallWizard.jar file
resides when executing this command.

5. Press Enter to view the license agreement.
6. Press Y to accept the license and N to reject the license agreement.
7. Enter the path to the directory where Sterling Selling and Fulfillment

Foundation is installed.
8. Press Enter.

9. In the Data Mart Database Connection Information screen, enter the database
user name.

10. Press Enter.

11. Enter the database password.
12. Press Enter.

13. Enter the database catalog name.
14. Press Enter.

15. Enter Database schema name.
16. Press Enter.

17. Enter the database host name.
18. Press Enter.

19. Enter the database port.
20. Press Enter.

21. Enter the path to the JDBC driver file.
22. Press Enter.

23. Enter the path to the second JDBC driver file, if required.
24. Press Enter. The Confirming Input Information message, with values for the

user name, password, catalog, host name, port, and the path to the JDBC
driver, is displayed.

25. Press Enter to confirm the value for each attribute. The database version
validation details are displayed.

26. Press Enter.

27. In the Staging Database Connection Information screen, enter the staging
database user name.

28. Press Enter. The Confirm Staging Database password message is displayed.
29. Press Enter.

30. Enter Staging database catalog name.
31. Press Enter.

32. Enter Staging database schema name.
33. Press Enter.

34. Enter Staging database host name.
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35. Press Enter.

36. Enter Staging database port.
37. Press Enter. The Confirm Staging Database Information message, with values

for catalog name, host name, and port, is displayed.
38. Press Enter to confirm the value for each attribute. The following message is

displayed: Database Version Validation Completed Successfully

39. Press Enter. The Installation Progress screen is displayed. After the installation
is complete, the following message is displayed: Installation is completed
successfully

Multischema Installation in Windows

About this task

To perform a multischema installation in Windows environment, perform these
steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Business_Intelligence_Application

folder.
3. Copy SCIInstallWizard.jar and sbi.jar to your designated path, for

example, D:/sbi/CDROM/SCIINSTALLWizard.jar.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

The Installation dialog box is displayed.
You must be in the directory in which the SCIInstallWizard.jar file resides
when executing this command.

5. Click Next to start the installation.
The License Conditions screen is displayed.

6. Review the license agreement and click Accept to accept the terms.
7. In the Sterling Selling and Fulfillment Foundation Folder screen, enter the

path to the folder in which Sterling Selling and Fulfillment Foundation, is
installed. Alternatively, click Select Folder and navigate to the location in
which Sterling Selling and Fulfillment Foundation, is installed, and click
Select Folder. This displays the folder's path in the Sterling Selling and
Fulfillment Foundation Folder screen.

8. Click Next.

9. In the Confirming Input Information screen that is displayed, verify that you
have selected the correct folder, and click Next. (To select another folder, click
Back and repeat steps 6, 7, and 8).

10. In the Installation Progress screen that is displayed, click Install to proceed
with the installation. To view detailed information about the progress of the
installation, click Show Details.

11. After the installation is completed, click Exit.

For details about errors that may have occurred during installation, refer to
the SBI_PreInstallSI.log file in the <INSTALL_DIR> directory.
Set up a database pool for the data warehouse schema and staging schema.
For each colony, you must associate the database pool pertaining to the data
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warehouse schema and staging schema to the table types BI and BI_STAGING
respectively. For more information about managing database pools and
colonies, refer to the Enterprise Onboarding for Multi-Tenancy Guide.

Note: During the installation of Sterling Selling and Fulfillment Foundation, if
you had chosen to install with no database DDLs and factory setup, execute
the following steps:
a. Install the database DDLs by executing the dbverify utility to verify the

database schema. For more information about verifying the database
schema, refer to the Selling and Fulfillment Foundation: Installation Guide.

b. Load the factory setup. To load the Sterling Business Intelligence database
factory defaults after the product installation, load the defaults using the
script applicable to your operating system. From the command line, run
the <INSTALL_DIR>/bin/loadDefaults.sh command on UNIX or Linux, and
or the <INSTALL_DIR>\bin\loadDefaults.cmd command on Windows, and
pass the absolute file path to the installer XML file, and the absolute path
to the factory setup XMLs:
v On UNIX or Linux:

loadDefaults.sh

<INSTALL_DIR>/installed_data/sbi/factorysetup/installer.xml

<INSTALL_DIR>/installed_data/sbi/factorysetup/XMLS

v On Windows:
loadDefaults.cmd

<INSTALL_DIR>\installed_data\sbi\factorysetup\installer.xml

<INSTALL_DIR>\installed_data\sbi\factorysetup\XMLS

Multischema Installation in UNIX
About this task

To perform a multischema installation in UNIX or Linux environment, perform
these steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Business_Intelligence_Application

folder.
3. Copy SCIInstallWizard.jar and sbi.jar to your designated path, for example,

D:/sbi/CDROM/SCIINSTALLWizard.jar.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

Note: You must be in the directory in which the SCIInstallWizard.jar file resides
when executing this command.

5. Press Enter to view the license agreement.
6. Press Y to accept the license and N to reject the license agreement.
7. Enter the path to the directory where Sterling Selling and Fulfillment

Foundation is installed.
8. Press Enter.

The Installation Progress screen is displayed. After the installation is complete,
the following message is displayed:
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Installation is completed successfully
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Chapter 6. Introduction to Installing the IBM Sterling Business
Intelligence Adaptive Applications Framework

Prior to installing the Sterling Business Intelligence Adaptive Applications
Framework, ensure that JDK1.5 or later version is installed in the system.

The Sterling Business Intelligence Adaptive Applications Framework component
can be installed only on Microsoft Windows. This installer installs the IBM Cognos
Adaptive Warehouse, the IBM Cognos Adaptive Analytics Development Studio
environment, and the Sterling Business Intelligence Analytics components.

The Sterling Business Intelligence Adaptive Applications Framework is installed on
server 5, as described in the topic Chapter 4, “Understanding the IBM Sterling
Business Intelligence Ecosystem,” on page 7.

Note: Ensure that there is at least 1 GB of free space available for installation.

Install the IBM Sterling Business Intelligence Adaptive Applications
Framework

About this task

To install the Sterling Business Intelligence Adaptive Applications Framework,
perform the following steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Adaptive_Analytics_Framework folder.
3. Copy SCIInstallWizard.jar to your designated path, for example,

D:/sbi/CDRomAnalytics_Framework.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

The Installation dialog box is displayed.

Note: You must be in the directory in which the SCIInstallWizard.jar file
resides when executing this command.

5. Click Next to start the installation. The License Conditions screen is displayed.
6. Review the license agreement and click Accept to accept the terms. The JDK

Directory screen is displayed.
7. Enter the path of the location in which JDK is installed. Alternatively, click

Select Folder and navigate to the location in which JDK is installed, and click
Select Folder.

8. Click Next to select the installation directory. Alternatively, click Select Folder
and navigate to the directory in which you want to install the Sterling
Business Intelligence Adaptive Applications Framework components, and click
Select Folder.
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The path to the directory in which you want to install the Sterling Business
Intelligence Adaptive Applications Framework is displayed in the Installation
Directory screen. This directory is referred to as <INSTALL_DIR> in
subsequent prompts.

9. Click Next.
10. In the Installation Progress screen that is displayed, click Install to proceed

with the installation. To view detailed information about the progress of the
installation, click Show Details.

11. After the installation is completed, click Exit.
The adapappsfw_win32_8.4.2_ml.tar.gz file is now available in the
<INSTALL_DIR> directory.
For details about any errors that may have occurred during the installation,
refer to the SBI_Analytics_Framework_PreInstallSI.log file in the
<INSTALL_DIR> directory.

12. Extract the adapappsfw_win32_8.4.2_ml.tar.gz file. The
adapappsfw_win32_8.4.27.16_ml.tar file is extracted.

13. Extract adapappsfw_win32_8.4.27.16_ml.tar file. The corresponding files are
extracted to the respective folders.

14. Run the issetup.exe in the <extracted folder>/win32 directory.
For completing the installation and configuration of the Adaptive Analytics
Framework, refer to theCognos 8 Analytics Applications Installation and
Configuration Guide.

15. After the installation is complete, open the Cognos Configuration and click
Save. This ensures that the cryptographic information is regenerated.
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Chapter 7. Install the IBM Sterling Business Intelligence
Adaptive Applications Runtime in Windows Environment

Before you begin

To install the Sterling Business Intelligence Adaptive Applications Runtime in
Windows environment, perform these steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Adaptive_Analytics_Runtime folder.
3. Copy SCIInstallWizard.jar to your designated path, for example,

D:/sbi/CDRomAnalytics_Runtime.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

The Installation dialog box is displayed.

Note: You must be in the directory in which the SCIInstallWizard.jar file
resides when executing this command.

5. Click Next to start the installation program.
The License Conditions screen is displayed.

6. Review the license agreement and click Accept to accept the terms.
The JDK Directory screen is displayed.

7. Enter the path of the location in which JDK is installed. Alternatively, click
Select Folder and navigate to the location in which JDK is installed and click
Select Folder.

8. Click Next to select the installation directory. Alternatively, click Select Folder
and navigate to the location where you want to install the Sterling Business
Intelligence Adaptive Applications Runtime components and click Select
Folder.
The path to the directory in which you want to install the Sterling Business
Intelligence Adaptive Applications Runtime to be installed is displayed in the
Installation Directory screen. This directory is referred to as <INSTALL_DIR>
in subsequent prompts.

9. Click Next.
10. In the Installation Progress screen, click Install to proceed with the installation.

To view detailed information about the progress of the installation, click Show
Details.

11. After the installation is completed, click Exit.
The adapappsfwrt_win32_8.4.2_ml.tar.gz file is now available in the
<INSTALL_DIR>/Analytics directory.
For details about any errors that may have occurred during the installation,
refer to the SBI_PreInstallSI.log file in the <INSTALL_DIR> directory.

12. Extract the adapappsfwrt_win32_8.4.2_ml.tar.gz file.
The adapappsfw_win32_8.4.27.16_ml.tar file is extracted.

13. Extract adapappsfw_win32_8.4.27.16_ml.tar file.
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The corresponding files are extracted to the respective folders.
14. Locate the issetup.exe file and run it.

For completing the installation and configuration of the Adaptive Applications
Runtime, refer to the Cognos 8 Analytics Applications Installation and
Configuration Guide.
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Chapter 8. Install the IBM Sterling Business Intelligence
Adaptive Applications Runtime in Linux or UNIX Environment

The Sterling Business Intelligence Adaptive Applications Runtime component can
be installed on UNIX (HP, IBM AIX, Sun Solaris, Linux). This installer installs the
IBM Cognos Adaptive Applications Runtime environment.

This runtime installation is used to execute the extract, transform, and load (ETL)
scripts that have been generated from the Adaptive Warehouse (development
environment).

The Sterling Business Intelligence Adaptive Applications Runtime is installed on
server 6, as described in the “Understanding the Sterling Business Intelligence
Ecosystem” topic.

Note: Ensure that there is at least 1 GB of free space available for installation.

Install the IBM Sterling Business Intelligence Adaptive Applications
Runtime in Linux or UNIX Environment

About this task

To install the Sterling Business Intelligence Adaptive Applications Runtime
components in Linux or UNIX environment, perform these steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Adaptive_Analytics_Runtime folder.
3. Copy SCIInstallWizard.jar to your designated path.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

Note: You must be in the directory where the SCIInstallWizard.jar file resides
when executing this command.

5. Press Enter to view the license agreement.
6. Press Y to accept the license and N to reject.
7. Enter the path of the location in which JDK is installed and press Enter.

The path to the directory in which you want to install the Sterling Business
Intelligence Adaptive Applications Runtime to be installed is displayed in the
Installation Directory screen. This directory is referred to as <INSTALL_DIR>
in subsequent prompts.

8. Press Enter.
After the installation is complete, the following message is displayed:
BUILD SUCCESSFUL

9. After the installation is completed, click Exit.
Depending on the version of the operating system, any one of the following
files is available in the <INSTALL_DIR>/Analytics directory:
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v For IBM AIX - adapappsfwrt_aix32_8.4.2_ml.tar.gz
v For Linux - adapappsfwrt_linuxi38632_8.4.2_ml.tar.gz
v For Sun Solaris - adapappsfwrt_solaris32_8.4.2_ml.tar.gz

For details about any errors that may have occurred during the installation,
refer to the SBI_PreInstallSI.log file in the <INSTALL_DIR> directory.

10. Depending on the version of the operating system, extract any one of the
following files:
v For IBM AIX - adapappsfwrt_aix32_8.4.2_ml.tar.gz
v For Linux - adapappsfwrt_linuxi38632_8.4.2_ml.tar.gz
v For Sun Solaris - adapappsfwrt_solaris32_8.4.2_ml.tar.gz

The required file is extracted.
11. Depending on the version of the operating system, extract any one of the

following files:
v adapappsfw_aix32_8.4.27.16_ml.tar
v adapappsfw_linuxi32_8.4.27.16_ml.tar
v adapappsfw_solaris32_8.4.27.16_ml.tar

The corresponding files are extracted to the respective folders.
12. To start the installation, enter ./issetup.

If you do not use XWindows, run an unattended installation.
For more information about running the unattended installation, completing
the installation, and configuring the Adaptive Applications Runtime, refer to
the Cognos 8 Analytics Applications Installation and Configuration Guide.
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Chapter 9. Introduction to Installing the IBM Sterling Business
Intelligence Analytics Content

Prior to installing the Sterling Business Intelligence Analytics Content, ensure that
JDK1.5 or later version is installed in the system.

The Sterling Business Intelligence Analytics Content component is available only
for Microsoft Windows. This installer installs the application content files in your
system.

The Sterling Business Intelligence Analytics Content is installed on server 5, as
described in the topic Chapter 4, “Understanding the IBM Sterling Business
Intelligence Ecosystem,” on page 7.

Note: Ensure that there is at least 50 MB of free space available for installation.

Install the IBM Sterling Business Intelligence Analytics Content
About this task

To install the Sterling Business Intelligence Analytics Content, perform these steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Adaptive_Analytics_Content folder.
3. Copy SCIInstallWizard.jar to your designated path, for example,

D:/sbi/CDRomAnalytics.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

The Installation dialog box is displayed.

Note: You must be in the directory in which the SCIInstallWizard.jar file
resides when executing this command.

5. Click Next to start the installation.
6. Enter the path to the folder in which JDK is installed. Alternatively, click

Select Folder and navigate to the location in which JDK is installed, and click
Select Folder.

7. Click Next to select the installation directory. Alternatively, click Select Folder
and navigate to the folder in which you want to install the Sterling Business
Intelligence Analytics Content component and click Select Folder.
The path to the directory in which you want the Sterling Business Intelligence
Analytics Content component to be installed is displayed in the Installation
Directory screen. This directory is referred to as <AC_INSTALL_DIR> in
subsequent prompts.

8. Click Next.
9. In the Installation Progress screen, click Install to proceed with the installation.

To view detailed information about the progress of the installation, click Show
Details.
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10. After the installation is completed, click Exit.
For details about any errors that may have occurred during the installation,
refer to the SBI_Analytics_PreInstallSI.log file in the <AC_INSTALL_DIR>
directory.

28 Sterling Business Intelligence: Installation Guide



Chapter 10. Install the IBM Sterling Business Intelligence
Content for Cognos 8 Business Intelligence

Prior to installing the Sterling Business Intelligence Content for Cognos 8 Business
Intelligence, ensure that JDK1.5 or later version is installed in the system.

Cognos 8 Business Intelligence Content can be installed on all platforms. This
installer installs the Dashboard reports and files required for communication
between the Cognos 8 Business Intelligence server and Sterling Business
Intelligence in your system. As part of this installation, the Sterling Business
Intelligence Content is deployed on the Cognos server.

The Cognos 8 Business Intelligence Content is installed on server 4, as described in
the topic Chapter 4, “Understanding the IBM Sterling Business Intelligence
Ecosystem,” on page 7

Note: Ensure that there is at least 50 MB of free space available for installation.

Install the IBM Sterling Business Intelligence Content for IBM Cognos
8 Business Intelligence

About this task

To install the Sterling Business Intelligence Content for Cognos 8 Business
Intelligence, perform the following steps:

Procedure
1. Place the Sterling Business Intelligence installation DVD in the appropriate

drive.
2. From the installation DVD, navigate to Cognos_8_BI_Content folder.
3. Copy SCIInstallWizard.jar to your designated path, for example,

D:/sbi/CDRomAnalytics_Cognos_8_BI_Content.
4. Execute the following command to start the installation wizard:

<JAVA_HOME>/bin/java -jar SCIInstallWizard.jar

The Installation dialog box is displayed.
You must be in the directory in which the SCIInstallWizard.jar file resides
when executing this command.

5. Click Next to start the installation.
The License Conditions screen is displayed.

6. Review the license agreement and click Accept to accept the terms.
The JDK Directory screen is displayed.

7. Enter the path in which the JDK is installed. Alternatively, click Select Folder
and navigate to the location where the JDK is installed and click Select Folder.

8. Click Next in the Installation Directory screen to select the installation
directory. Alternatively, click Select Folder and navigate to the directory in
which you want to install the Cognos 8 Business Intelligence Content
component and click Select Folder.
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In the Installation Directory screen, the path to the directory in which you
want to install the Cognos 8 Business Intelligence Content is displayed. This
directory is referred to as <BI_COGNOS8_HOME> in subsequent prompts.

9. Click Next.
10. In the Installation Progress screen, click Install to proceed with the installation.

To view detailed information about the progress of the installation, click Show
Details

11. After the installation is completed, click Exit.
For details about any errors that may have occurred during the installation,
refer to the SBI_Analytics_Cognos_8_BI_Content_PreInstallSI.log file in the
<BI_COGNOS8_HOME> directory.
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Chapter 11. Deploy IBM Sterling Business Intelligence

About this task

To deploy Sterling Business Intelligence, perform the following steps:

Procedure
1. “Deploy the IBM Sterling Business Intelligence Application”
2. “Set Up the IBM Sterling Business Intelligence Authentication Mechanism” on

page 32
3. “Setting Up Access to IBM Cognos Administration and Reporting” on page 32
4. “Configure the IBM Cognos 8 Business Intelligence Server” on page 36
5. “Setup for Accessing the IBM Cognos 8 Business Intelligence Server from�the

IBM Sterling Business Intelligence Application” on page 37
6. “Set Up Environment for IBM Cognos Analytic Applications” on page 37
7. “Configure the IBM Cognos 8 Analytic Applications” on page 38
8. “Deploy Analytics Content” on page 38
9. “Deploy the Dashboard Reports to Content Store” on page 42

Deploy the IBM Sterling Business Intelligence Application
About this task

Perform the following steps in the Sterling Transaction System (server 1) in which
the Sterling Business Intelligence Application is installed.

Procedure
1. To create an application EAR file, run the following command from the

<INSTALL_DIR>/bin directory:
v For Linux or UNIX:

./buildear.sh -Dappserver=jboss -Dwarfiles=smcfs,sma,sbc,sbi
-Dearfile=smcfs.ear create-ear

v For Windows:
./buildear.cmd -Dappserver=jboss -Dwarfiles=smcfs,sma,sbc,sbi
-Dearfile=smcfs.ear create-ear

Here, the value of Dappserver depends upon the application server. For JBoss,
pass jboss in this parameter. For BEA WebLogic, pass weblogic and for IBM
WebSphere, pass websphere.
Running this command includes the sbi.war file into the smcfs.ear file.

2. To create the documentation EAR file, run the following command from the
<INSTALL_DIR>/bin directory:
v For Linux or UNIX:

./buildear.sh -Dappserver=jboss -Dwarfiles=smcfsdocs
-Dearfile=smcfsdocs.ear create-doc-ear

v For Windows:
./buildear.cmd -Dappserver=jboss -Dwarfiles=smcfsdocs
-Dearfile=smcfsdocs.ear create-doc-ear
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Here, the value of Dappserver depends upon the application server. For JBoss,
pass jboss in this parameter. For BEA WebLogic, pass weblogic and for IBM
WebSphere, pass websphere.
For more information about deploying the WAR and EAR files, refer to the
Selling and Fulfillment Foundation: Installation Guide.

Set Up the IBM Sterling Business Intelligence Authentication
Mechanism

Before you begin

Prior to setting up the Sterling Business Intelligence Authentication Mechanism,
perform the following tasks:
1. Copy the <BI_COGNOS8_HOME>/lib/sscap-auth.jar file to the <Cognos 8

Installation Directory>/c8/webapp/p2pd/WEB-INF/lib folder into the
machine in which Cognos 8 server has been installed.

2. Copy the <BI_COGNOS8_HOME>/analytics.properties.sample file to the
<Cognos 8 Installation Directory>/webapps/p2pd/WEB-INF/classes folder.

3. Save the <Cognos 8 Installation Directory>/webapps/p2pd/WEB-INF/classes/
analytics.properties.sample file as analytics.properties in the same folder.

4. Change the value of the sscap.app.url property to point to the Sterling Selling
and Fulfillment Foundation URL:
sscap.app.url=http://hostname:port/smcfs

About this task

To set up the Sterling Business Intelligence Authentication Mechanism, perform the
following tasks:

Procedure
1. Launch IBM Cognos Configuration.
2. Click Security > Authentication> Cognos.
3. Select False from the Allow anonymous access drop-down list.
4. Add a new resource namespace, smcfs, of the type Custom Java Provider.
5. Select Security > Authentication.
6. Right-click and select New Resource > Namespace and enter the namespace ID

smcfs.
7. In the Resource Properties panel, enter

com.yantra.authenticator.YantraAuthentication as the Java class name.
8. Restart IBM Cognos Configuration.

Setting Up Access to IBM Cognos Administration and Reporting
To help increase the security of your business systems and data with Sterling
Business Intelligence, you can be selective in assigning access to the IBM Cognos
administrative functions, reports, folders, and packages. Use the Sterling Business
Intelligence Administrator platform resource to assign these permissions.

To set up access to IBM Cognos Administration and Reporting, perform the
following tasks:
v Control access to IBM Cognos Administration
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v Control access to IBM Cognos Reports, Folders, and Packages

Control Access to IBM Cognos Administration
To limit user access to the IBM Cognos administrative functions you must grant
the necessary permissions to the Sterling Business Intelligence Administrator
resource in Sterling Business Intelligence.

Before you begin

Note: Before performing the task of assigning permissions, ensure that you have
created the corresponding security groups in the Applications Manager.

Procedure
1. Launch Applications Manager.
2. Select Application > Platform.
3. From the Application Rules Side panel, select Security > Groups.

The Groups screen is displayed in the work area.
4. Select the group to which you want to provide the Sterling Business

Intelligence Administrator resource permission.
5. From the Permissions screen, select Application > Sterling Business Intelligence

> Entities > Business Intelligence Admin.
6. Right click and select Grant Permissions.
7. Click Save.

Editing the System Administrator Role in IBM Cognos
To limit access to the IBM Cognos administration functionality, modify the System
Administrator role. You can complete this task after you set the necessary access to
Cognos administration.

When a user launches IBM Cognos Connection through the Console, all the user
groups to which the corresponding user belongs are displayed. If the user has
permission to access the Business Intelligence Administrator, the user is able to
view all the groups defined in the database, and an additional group called
smcfs/SYSTEM. Otherwise, the user can view only the groups to which the user
belongs.

By default, all the users have administrative capabilities because the Everyone
group (which includes all the users) is included under the System Administrator
role.

Add the smcfs/SYSTEM Group
When you grant BI Admin rights to a user in the Applications Manager, a new
group called SYSTEM is displayed in the user's list of groups under the smcfs
namespace.

About this task

To add the smcfs/SYSTEM group to the System Administrator role, perform the
following tasks:

Procedure
1. Start your Web browser and enter the URL of your Cognos 8 application (the

default is http://localhost/cognos8).
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The Home page is displayed.
2. In the Cognos Administration screen, click Administer Cognos.
3. Click the Security tab.
4. Locate smcfs in the list of roles, and click it.
5. Locate SYSTEM in the list, and click Set Properties in the Action column.

The Set Properties - SYSTEM screen is displayed.
6. Click the Permissions tab.
7. Select the Override the access permissions acquired from the parent entry

check box.
8. Click Add.

The Select Entries (Navigate) - System screen is displayed.
9. Click the smcfs namespace.

The Select Entries (Navigate) - System screen is displayed.
10. In Available Entries, select the System check box, and click the arrow to move

it to the Selected Entries list.
11. Click OK.

Remove the Everyone Group from the Sys Admin Role
After adding the smcfs/SYSTEM group to the System Administrator role, remove
the Everyone group from the System Administrator role.

About this task

To remove the Everyone group from the System Administrator role, perform the
following steps:

Procedure
1. Start your Web browser and enter the URL of your IBM Cognos 8 application

(the default is http://localhost/cognos8).
The Home page is displayed.

2. In the IBM Cognos Administration screen, click Administer IBM Cognos
content.

3. Click Security tab.
4. Locate smcfs in the list of roles, and click smcfs.
5. Locate SYSTEM in the list, and click Set Properties in the Action column.

The Set Properties - SYSTEM screen is displayed.
6. Click the Members tab.
7. Click Everyone and click Remove.

Users who have permission to access the Business Intelligence Administrator
will now have administrative capabilities.

Control Access to IBM Cognos Reports, Folders, and
Packages

To control access to IBM Cognos reports, folders, and packages through
Applications Manager, perform the following tasks:

Procedure
1. Start your Web browser and enter the URL of your IBM Cognos 8 application

(the default is http://localhost/cognos8).
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The Home page is displayed.
2. In the IBM Cognos Administration screen, click Administer IBM Cognos

content.
3. Select Security > Capabilities.
4. Locate the entry for which you want to set access permissions.
5. Click Set Properties in the Action column.

The Set Properties screen is displayed.
6. Click Permissions tab.

You can choose to either use the permissions of the parent entry or select
permissions specifically for this entry.
v To use the permissions of the parent entry, clear the Override the access

permissions acquired from the parent entry option. If you are prompted to
use the parent permissions, click OK in the prompt dialog box. Click OK in
the Set Properties screen.

v To set specific access permissions for the entry, select the Override the
access permissions acquired from the parent entry option.

7. To remove an entry from the list, click the entry and click Remove.
8. To specify a new entry for which you want to grant or deny access, click Add.
9. Click OK.

10. Select the smcfs namespace.
The Select Entries screen is displayed.

11. In Available Entries panel, select the SYSTEM check box and click the arrow to
move it to the Selected Entries panel.

12. Select the entries using one of the following methods:
v To select from the entries list, click the appropriate namespace, and select

the corresponding users, groups, or roles.
v To enter new names, click Type and type the names of the groups, roles, or

users in the Entries field. Separate multiple entries with a semicolon (;), for
example, smcfs/SYSTEM;Cognos/Everyone

13. Click the arrow to move entries to the Selected entries panel.
14. Click OK.

The Set Properties screen is displayed.
15. Click the Permissions tab.
16. Click Add.

The Select Entries screen is displayed.
17. Select smcfs and click the arrow to move smcfs to the Selected Entries panel.
18. Click OK.

The Set Properties screen is displayed. Notice that smcfs is added to the Name
column.

19. To specify permissions for a user, group, or role, select the appropriate check
box in the Name column, and then select the appropriate permission check
boxes in the Grant or Deny columns. The icon next to each user, group, or role
in the Permissions column represents the type of access granted or denied.
Repeat this step for each user, group, and role.

20. If you want to replace the existing permissions of the child entries with the
permissions you set for this entry, in the Option section, select the Delete the
access permissions of all child entries check box.

Note: This option appears only in the context of entries that are containers.

Chapter 11. Deploy IBM Sterling Business Intelligence 35



21. Click OK.

Configure the IBM Cognos 8 Business Intelligence Server
You should apply Sterling Business Intelligence-specific styles to the Cognos 8
Business Intelligence reports, and add the system.xml definition to enable the
relevant toolbar actions for the reports.

About this task

To apply Sterling Business Intelligence-specific styles to reports, perform the
following tasks:

Note: It is recommended that you take a back up of the existing
reportstudio_en.xml and GlobalReportStyles.css files.

Procedure
1. Edit the GlobalReportStyles.css file under <c8_installation>\c8\bin,

<c8_installation>\c8\reportstyles, <c8_installation>\c8\webcontent\
reportstyles, and <c8_installation>\c8\webcontent\schemas to add the content
of <BI_COGNOS8_HOME>\rs-export\Style_Sheet\SBIReportStyles.css at the
end.

2. Edit the reportstudio_en.xml file under <c8_installation>\c8\msgsdk and
<c8_installation>\c8\webcontent\pat\res to add the content of
<BI_COGNOS8_HOME>\rs-xport\Style_Sheet\
SBI_reportstudio_en_sample.xml at the end, just before the </section> tag. You
must add only the content between the comment tags <!-- SBI STARTS --> &
<!-- SBI ENDS -->

Note: To localize the Global Class Extensions in the Cognos Report Studio, you
must use the contents in the SBI_report_Studio_en.xml file. Localize the
contents in the required language, and copy the contents into the
reportstudio_<languange>.xml file. For example, if you want to view the
Global Class Extensions in the Cognos Report Studio in French, localize the
contents of SBI_report_Studio_en.xml in French and copy the contents into the
reportstudio_fr.xml

3. Add the blue-top.png image file taken from <BI_COGNOS8_HOME>\rs-
export\Style_Sheet, and copy the blue-top.png file into <c8
intallation>\c8\webcontent\samples\images.

4. Ensure that the <c8 intallation>\c8\webcontent\samples\images directory has
been created and the appropriate permissions granted to users read from this
directory.

5. Add the following lines to system.xml under <cognos install location>\c8
emplates\ps\portal\ and <cognos install location>\c8 emplates\ps\. If you
have not defined the ui_hide parameter in system.xml, add the instructions
provided here. If you have already defined the ui_hide parameter, add only
those line items that are not defined.
<param name="ui_hide">
<RV_HEADER/>
<RV_TOOLBAR_BUTTONS_DOWNLOAD/>
<RV_TOOLBAR_BUTTONS_SAVE/>
<RV_TOOLBAR_BUTTONS_SAVEAS/>
<RV_TOOLBAR_BUTTONS_SEND/>
<RV_TOOLBAR_BUTTONS_RUN/>
<RV_TOOLBAR_BUTTONS_XLS/>
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<RV_TOOLBAR_BUTTONS_XLS_CSV/>
<RV_TOOLBAR_BUTTONS_XML/>
<RV_TOOLBAR_BUTTONS_XLS_SPREADSHEETML/>
<RV_TOOLBAR_BUTTONS_XLS_XLWA/>
<RV_TOOLBAR_BUTTONS_XLS_XLS/>
<RV_TOOLBAR_BUTTONS_XLS_SINGLEXLS/>
<RV_TOOLBAR_BUTTONS_DRILLDOWN/>
<RV_TOOLBAR_BUTTONS_DRILLUP/>
<RV_TOOLBAR_BUTTONS_GOTO/>
<RV_TOOLBAR_BUTTONS_ADD_THIS_REPORT/>
<RV_TOOLBAR_BUTTONS_ADD_TO_MY_BOOKMARKS/>
<RV_TOOLBAR_BUTTONS_ADD_TO_MY_FOLDERS/>
<RV_TOOLBAR_BUTTONS_KEEP_THIS_VERSION/>

Setup for Accessing the IBM Cognos 8 Business Intelligence Server
from�the IBM Sterling Business Intelligence Application

About this task

To launch Cognos 8 Business Intelligence Server from Sterling Business
Intelligence, you must configure the analytics.reportnet.url property in the
<INSTALL_DIR>/properties/customer_overrides.properties file.

The Cognos 8 Business Intelligence Server URL format is:

http://<machinename>/cognos8/cgi-bin/cognos.cgi

Note: In this URL, replace <machinename> with the machine name or the IP
address of the Cognos 8 Business Intelligence Server installation machine. Also, if
you have changed the reference URL for Cognos using the Cognos Configurator,
replace cognos8 with the correct path.

For additional information about modifying properties and the
customer_overrides.properties file, refer to the Selling and Fulfillment Foundation:
Installation Guide.

You must also configure the analytics.namespace property in the
<INSTALL_DIR>/properties/customer_overrides.properties file. This property
indicates the namespace that is to be configured to authenticate users in Cognos 8
Business Intelligence.

Set Up Environment for IBM Cognos Analytic Applications
To set up the environment for the Cognos 8 Analytic Applications, perform the
following steps:
1. Set up the Content Store (on server 7).
2. Set up database connectivity for the Content Store (from server 4).
3. Configure the Web server (involves setting up virtual directories on server 4).
4. Set up data sources (from IBM Cognos Connection on server 4). Ensure that

you create the following data sources in the Cognos 8 Business Intelligence
server:
v Sterling Staging Data Source: This data source is mapped to the staging

schema.
v Sterling Data Source: This data source is mapped to the Sterling Data Mart

database schema.
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Note: In a distributed installation, you must ensure that the Connect String
provided in the data source connection is the same in all the database clients.

For more information about setting up the environment for the Cognos 8 Analytic
Applications, refer to the Cognos 8 Analytic Applications Installation and
Configuration Guide and for data source connections, refer to the Cognos 8
Analytic Applications Installation and Configuration Guide and the Cognos 8
Analytic Applications Adaptive Warehouse User Guide that is shipped along with
the Sterling Business Intelligence Adaptive Applications Framework component.

Configure the IBM Cognos 8 Analytic Applications
You must configure the Cognos 8 Analytic Applications to make it work in your
Cognos environment.

Ensure that the cryptographic settings are completed. If you have a distributed
installation, it is recommended that you set the value of the Store Symmetric Key
field to False locally. For more information about changing the cryptographic
settings and configuring the Cognos 8 Analytics Applications, refer to the Cognos 8
Analytics Applications Installation and Configuration Guide. This guide contains
separate instructions for single-computer installation and distributed installation.
Follow the appropriate configuration instructions.

Deploy Analytics Content
Deploying the Analytics Content includes the following steps:

Procedure
1. “Set Up the Adaptive Warehouse Content”
2. “Deploy the Adaptive Warehouse Content to Content Store” on page 39
3. “Set Up the Adaptive Analytics Content” on page 40
4. “Deploy the Adaptive Analytics Content to Content Store” on page 41

Set Up the Adaptive Warehouse Content
Setting up the Adaptive Warehouse content includes setting up content for the
warehouse schema.

About this task

To set up the Adaptive Warehouse content for the Data Mart warehouse schema,
perform the following steps:

Procedure
1. Launch the Cognos Adaptive Warehouse application from the Cognos AAF

Development server (installed on server 5, as described in the topic Chapter 4,
“Understanding the IBM Sterling Business Intelligence Ecosystem,” on page 7.

2. Create a new project in Adaptive Warehouse. To create a new project in
Adaptive Warehouse, you must first create a data source connection that refers
to the data mart database. It is recommended that the data source connection
be named Sterling Data Source and it refers to the data mart schema. For
more information about creating a project in Adaptive Warehouse, refer to the
Cognos 8 Analytic Applications Adaptive Warehouse User Guide.

3. From the Actions menu of the Adaptive Warehouse application, select Import
from Content Library.
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4. Click Browse, and select the library index file that you want to import from.
This file is available in the directory in which the Adaptive Warehouse content
is installed, and has a .pwi extension, for example, /<AC_INSTALL_DIR>/
aw-export/sterling data source export/sterling data source export.pwi.

5. Click Open.
6. Click Next.
7. In the Conflict Resolution screen, select the conflict resolution that you want

to apply. By default, Full Upgrade is selected. For more details about conflict
resolution strategy, refer to the Cognos 8 Analytic Applications Adaptive
Warehouse User Guide.

8. Click Next.
The details of the objects that you are importing are displayed.

9. Click Finish to run the import.
10. In the Data Source Mapping dialog box, select the Cognos 8 Content Manager

Data Sources corresponding to Sterling Staging Data Source.
Note: The Sterling Staging data source should point to the Sterling Staging
Database schema, (installed on server 3, as described in the topic Chapter 4,
“Understanding the IBM Sterling Business Intelligence Ecosystem,” on page 7.

11. Click OK.
A pop-up window is displayed with warning messages. You can ignore the
warning messages pertaining to Common Code Union Source, SO Actual
Confirmed Union, Category Union, and Orphan Data.

12. Click OK.
The Validation Results screen is displayed.

13. Click Close.
14. Click OK.
15. From the Actions menu, select Synchronize Target Metadata.
16. From the File menu, select Save to save the project.

Results

For more information about working with projects in Adaptive Warehouse, refer to
the Cognos 8 Analytic Applications Adaptive Warehouse User Guide.

Deploy the Adaptive Warehouse Content to Content Store
About this task

Deploying the Adaptive Warehouse content includes deploying content for the
Data Mart warehouse schema.

To deploy the Adaptive Warehouse content for the Data Mart warehouse schema to
the Content Store, perform the following steps:

Procedure
1. Open the Sterling Data Source project.
2. Click the Target button to navigate to the target model.
3. Click Packages.

The following packages are displayed:
v Sterling Data Source
v Sterling Data Source Source
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4. Select the Sterling Data Source package.
5. From the Actions menu, navigate to Package > Publish Packages.

The Publish Wizard-Select Location Type screen is displayed.
6. In the Publish Wizard-Select Location Type screen, make a choice about

whether to publish the package to Cognos 8 Content Store or to a network
location.
v To enable model versioning when publishing to the Cognos 8 Content Store,

select the Enable model versioning check box and enter the number of
model versions pertaining to the packages that are to be retained.

Note: To delete all but the most recently published version of the model on
the server, select the Delete all previous model versions check box.

v To validate your warehouse model prior to publishing, clear the Verify the
package before publishing check box.

Note: It is recommended that you retain the default selection in order to
ensure that the package is complete, and does not contain any errors.

7. Click Next.
The Add Security screen is displayed.

8. Click Next.
The Publish Wizard-Options screen is displayed.

9. Click Publish.
10. Click Finish.

A warning message is displayed in the Verify Model screen, indicating that
the package contains orphan dimensions. You can ignore the message.
To publish the Sterling Data Source Source package, select the Sterling Data
Source Source package and repeat steps 4 to 9.

11. Click Close.

Set Up the Adaptive Analytics Content
About this task

You must import business content from a content library into a project to take
advantage of the content included in Adaptive Analytics. The content library
contains information packages, metric types, hierarchies, operational report
specifications, and global data pertaining to the Adaptive Analytics application.

To set up the Adaptive Analytics content, perform the following steps:

Procedure
1. Launch the Cognos Adaptive Analytics application.
2. Create a new project by selecting a data source connection that references the

data mart Adaptive Warehouse model. It is recommended that you specify the
project name as Sterling Analytics. For more information about creating a new
project, refer to the Cognos 8 Analytic Applications Adaptive Analytics User
Guide.

3. From the Actions menu, select Import from Content Library.
4. Click Browse, navigate to the location where the Analytics Content is installed,

and select the library index file (.aai) that contains the Adaptive Analytics
content, for example, /<AC_INSTALL_DIR>/aa-export/Export.aai that is
necessary for the reports that you want to create.
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5. Click Open.
The Import screen is displayed. By default, all the objects are selected.

6. Click OK.
A pop-up window is displayed with messages that state: "Warning: Unable to
find a time hierarchy". You can ignore these messages.

7. Click Proceed.
8. From the File menu, select Save to save the project.
9. From the Actions menu, select Assignment Editor to assign a user or user

group from the smcfs namespace to the Sterling Analytics Package.

Results

For more information about assigning a user to the information package, refer to
the Cognos 8 Analytic Applications Adaptive Analytics User Guide.

Deploy the Adaptive Analytics Content to Content Store
To deploy the Adaptive Analytics content to Content Store, you must create a
deployment archive in Adaptive Analytics. To create a deployment archive,
perform these steps:

Procedure
1. From the Actions menu in the IBM Cognos Adaptive Analytics application,

select Generate Deployment Archive.
2. In the Save As dialog box, navigate to any local folder where you want to save

this archive file.
3. In the File Name box, enter a name for the archive.
4. Click Save.

A message is displayed in the Validate Object screen.
5. Click Close.
6. Copy the generated deployment archive from the local folder that you specified

in Step 2 to the <COGNOS_HOME>/c8/deployment folder.

Note: If the Cognos 8 BI server and the AAF is not installed on the same
machine, then you have to copy the deployment archive to the
<COGNOS_HOME>/c8/deployment folder on the Cognos 8 BI server machine.

Results

The deployment archive is created, and you can now publish your reports in
Cognos Connection.

For more information about publishing your reports in IBM Cognos Connection,
refer to the Cognos 8 Analytic Applications Adaptive Analytics User Guide.

Note: You cannot view data in the reports until the data is loaded into the
datamart. For more information about loading data into the datamart and setting
up load management, refer to the Sterling Business Intelligence: Implementation Guide.
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Deploy the Dashboard Reports to Content Store
About this task

Note: Dashboards.zip should be imported to content store only after importing
Adaptive Analytics Deployment Archive.

To deploy the dashboards to Content Store, perform the following steps:

Procedure
1. Copy the <BI_COGNOS8_HOME>/Dashboards.zip file to the

<COGNOS_HOME>/c8/deployment folder.
2. Launch Cognos Connection
3. Import the Dashboards.zip file to Content Store.

For more information about importing the deployment archive to Content
Store, refer to the Cognos 8 Administration and Security Guide.
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Chapter 12. Verify the IBM Sterling Business Intelligence
Installation

To verify the Sterling Business Intelligence installation, you must launch the
Sterling Business Intelligence application, launch the reports, and perform load
management.

About this task

Note: It is assumed that all the services and servers have been restarted after the
execution of configuration-related tasks.

To launch Sterling Business Intelligence, perform these steps:

Procedure
1. Open a browser and type the corresponding URL in the address bar, for

example, http://<hostname>:<port>/sbi/bi/launch.jsp
2. Click Go.

The Sterling Business Intelligence Login page is displayed.
3. Enter a valid Login ID and Password.
4. Click Sign In.

The Sterling Business Intelligence application home page is displayed.

Note: The Sterling Business Intelligence application screens have been designed
for 1024x768 resolution. For better viewing experience, change the display
resolution accordingly.

Launch the IBM Sterling Business Intelligence Report
Before you begin

To launch a Sterling Business Intelligence report, perform these steps:

Procedure
1. Launch the Sterling Business Intelligence application.

The Sterling Business Intelligence application home page is displayed.
2. From the Order menu, select the report you want to view.

The corresponding report is displayed.

Results

After the verification is completed, you must load data into the data mart
database. Prior to starting the load management activities, ensure that all servers
are time synched using services like Network Time Protocol (NTP) to a single clock
source. In case the Platform considerations do not allow for time synching, the IBM
Cognos server should run one minute slower than the OLTP server. For more
information about load management, refer to the Sterling Business Intelligence:
Implementation Guide.
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Chapter 13. Installing IBM Sterling Business Intelligence
Language Pack

Before installing the Sterling Business Intelligence language pack, ensure that you
have successfully installed Sterling Selling and Fulfillment Foundation, Release 9.1.

Language packs are compressed files that are compatible with the UNIX, Linux,
and Windows operating systems. Ensure that you install the Sterling Selling and
Fulfillment Foundation language pack, before you install the Sterling Business
Intelligence language pack. For more information about installing the Sterling
Selling and Fulfillment Foundation language pack, refer to the Selling and
Fulfillment Foundation: Installation Guide.

Install the Language Pack for IBM Sterling Business Intelligence
Dashboard Literals

About this task

To install and localize the language pack for dashboard literals, perform the
following tasks:

Procedure
1. Extract the SBI-Analytics9.1_<language>_<locale>.zip file from the language

pack CD to the <BI_COGNOS8_HOME> directory. Ensure that the
sbianalyticsbundle_<language>_<locale>.properties file exists in
<BI_COGNOS8_HOME>/resources/ directory.

2. Ensure that the environment variables BI_RT and BI_COGNOS8_HOME are correctly
set, For example in UNIX,
export BI_RT = <BI_COGNOS8_HOME>

export BI_COGNOS8_HOME = <BI_COGNOS8_HOME>

The <BI_COGNOS8_HOME> directory is the root directory where the Sterling
Business Intelligence content for IBM Cognos 8 Business Intelligence is
installed.

3. Copy the following jar files to <BI_COGNOS8_HOME>/lib folder from
<COGNOS_HOME>/c8/webapps/p2pd/WEB-INF/lib folder.
v axis.jar
v axisCrnpClient.jar
v CAM_AAA.jar
v CAM_AAA_CustomIF.jar
v commons-discovery.jar
v commons-logging-1.0.4.jar
v dom4j.jar
v jaxrpc.jar
v saaj.jar
v soap.jar
v xalan.jar
v xercesImpl.jar
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v xml-apis.jar
4. Ensure that you have disabled the Cognos 8 Business Intelligence

authentication.
5. To localize the dashboard literals in the <BI_COGNOS8_HOME> folder, copy execute

the following command from the <BI_COGNOS8_HOME>/bin folder: ant -f
sbilocalizer.xml import

Note:

v If you have installed Sterling Business Intelligence Content for IBM Cognos 8
Business Intelligence and Sterling Business Intelligence on two different
machines, you must modify the following line of the XML by replacing
localhost with the IP address of the machine on which Sterling Business
Intelligence content for Cognos 8 Business Intelligence has been installed
before you execute the command:
<property name="cognosurl" value="http://localhost:<port>/p2pd/
servlet/dispatch"/>

The sbilocalizer.xml command reads all the bundles in the
<BI_COGNOS8_HOME>/resources folder. It then adds the literal translations for
each locale into the dashboard definitions present in the <BI_COGNOS8_HOME>/
reports folder. The modified dashboard definitions are copied into the
<BI_COGNOS8_HOME>/localizedreports folder, and added into the content
repository. When the dashboards are generated again, the literals are displayed
according to the user's locale.

6. Ensure that you enable the Cognos 8 Business Intelligence authentication.

Install Language Pack for IBM Cognos Adaptive Warehouse
About this task

To install the language pack to localize the IBM Cognos Adaptive Warehouse,
perform the following tasks:

Procedure
1. Extract the SBI-Analytics9.1_<language>_<locale>.zip file from the language

pack CD to the <AC_INSTALL_DIR> directory.
2. Launch the IBM Cognos Adaptive Warehouse application and click on the

Target tab to open the Target view.
3. From Project menu, navigate to Languages > Define Languages. The Define

Languages window is displayed.
4. From the Available Languages list, select each language that you want to add

and click the arrow button to move it to the Project languages box and click
OK.

5. From the Project menu, navigate to Languages > Import Translation File. The
Import Translation File window is displayed.

6. From the Project Languages list, select the required project language.
7. Select the <AC_INSTALL_DIR>\resources\

sbiawbundle_<languagecode>_<localecode>.txt file that must be imported.
Sterling Business Intelligence Analytics Content is installed in
the<AC_INSTALL_DIR> folder.

8. Click OK.
9. Click Save.
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10. In the Target tab, in the Project Viewer pane, click on Packages > Sterling
Data Source.

11. In Properties window click on Language, Languages window is displayed.
12. In the Languages window, select the language that you want to add from the

Available Languages list and click the arrow button to move it to the Project
languages box. Click OK.

13. Click Save.
14. Publish the Sterling Data Source Package.

Install Language Pack for IBM Cognos Adaptive Analytics
Before you begin

Before installing the applications language pack, ensure that you have installed the
Sterling Selling and Fulfillment Foundation language pack. For more information
about installing the Sterling Selling and Fulfillment Foundation language pack,
refer to the Selling and Fulfillment Foundation: Installation Guide.

About this task

To install the language pack to localize the IBM Cognos Adaptive Analytics,
perform the following tasks:

Procedure
1. Extract the SBI-Analytics9.1_<language>_<locale>.zip file from the language

pack CD to the <AC_INSTALL_DIR> directory.
2. Launch the IBM Cognos Adaptive Analytics application and open the project

that you want to localize.
3. From Project menu, navigate to Languages > Define Languages. The Define

Languages window is displayed.
4. From the Available Languages list, select each language that you want to add

and click the arrow button to move it to the Project languages box and click
OK.

5. From the Project menu, navigate to Languages > Import Translation File. The
Import Translation File window is displayed.

6. From the Project Languages list, select the required project language.
7. Sterling Business Intelligence Analytics Content is installed in the

<AC_INSTALL_DIR> folder. Select the following file to be imported:
v For Latin languages,

<AC_INSTALL_DIR>\resources\
sbiaabundle_<languagecode>_<localecode>.csv

v For multibyte languages,
<AC_INSTALL_DIR>\resources\
sbiaabundle_<languagecode>_<localecode>.txt

8. Click OK.
9. Click Save.

10. From the Actions menu, select Generate Deployment Archive. The Save As
window is displayed

11. In the File name box, enter a name for the archive.
12. Click Save. The Validate Object dialog box is displayed.
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13. Click Close. The deployment archive is created. You can now publish your
reports in IBM Cognos Connection. For more information about publishing
your reports in IBM Cognos Connection, refer to the IBM Cognos 8 Analytic
Applications Adaptive Analytics User Guide.

Install the Language Pack for IBM Sterling Business Intelligence
About this task

To install the Sterling Business Intelligence language pack, perform the following
steps.

Procedure
1. Extract the SBI9.1_<language>_<locale>.zip file from the language pack CD to

the <INSTALL_DIR> directory.
2. Install the documentation help language pack by running the following script

from <INSTALL_DIR>/bin:
v For Linux or Unix:

./sci_ant.sh -f csHelpUtil.xml -DlocaleCode=<LOCALE_CODE>

v For Windows:
./sci_ant.cmd -f csHelpUtil.xml -DlocaleCode=<LOCALE_CODE>

3. Include the following property in the customer_overrides.properties file:
v For Linux or Unix:

yfs.yfs.onlinehelp.path.overrideforlocale.<LOCALE_CODE>=/smcfsdocs/
yfscommon/online_help/<LOCALE_CODE>

v For Windows:
yfs.yfs.onlinehelp.path.overrideforlocale.<LOCALE_CODE>=\smcfsdocs\
yfscommon\online_help\<LOCALE_CODE>

Here, <LOCALE_CODE> refers to [language_code]_[country_code]. For more
information about using the customer_overrides.properties file, refer to the
Selling and Fulfillment Foundation: Properties Guide. For example, on Linux or
Unix:
German locale: yfs.yfs.onlinehelp.path.overrideforlocale.de_DE=/
smcfsdocs/yfscommon/online_help/de_DE

French locale: yfs.yfs.onlinehelp.path.overrideforlocale.fr_FR=/
smcfsdocs/yfscommon/online_help/fr_FR

4. Ensure that you re-create the resource JAR file and the EAR file.

Localize IBM Sterling Business Intelligence Reports and Dashboard
Data

You can localize the data in the Sterling Business Intelligence reports and
dashboards using the IBM Cognos Adaptive Warehouse application. All the data
present in a dashboard that describing an entity, for example, Category
Description, Region Description, Buyer Description and so on, are localized in the
data warehouse database. The data warehouse database contains localized data
from the YFS_LOCALIZED_STRINGS table, which is transformed and added as
additional columns.
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Before you begin

Note: Before you start the data localization process, the database factory default
values must be localized. For more information about localization for multilingual
installation, refer to the Selling and Fulfillment Foundation: Localization Guide.

About this task

To localize the data in the Sterling Business Intelligence reports and dashboards,
perform the following tasks:

Procedure
1. Launch the IBM Cognos Adaptive Warehouse application. By default, the

application opens in the Warehouse view.
2. From the Actions menu, select Edit Data languages.

The Specify Project Languages pop-up window is displayed.
3. Click Add.
4. Enter the New Languages and Language code.
5. Click OK.
6. Click Synchronize Target Metadata.
7. Click Save and perform the load management.

For more information about performing load management, refer to the Cognos 8
Analytic Applications Adaptive Warehouse User Guide.

Localizing the Factory Setup Data
Besides storing your transactional data, the database also stores configuration data,
such as error codes. This means that the database may need to store values in a
language-specific format. If these database literals are not localized, screen literals
are displayed inconsistently, with some being displayed in the localized language
and others being displayed in English.

To localize the factory setup data, perform the following tasks:
1. Extract the SBI9.1_<language>_<locale>.zip file from the language pack CD to

the <INSTALL_DIR> directory. <INSTALL_DIR> is the directory where the Sterling
Selling and Fulfillment Foundation is installed. Ensure that the file
en_US_sbifcliterals2translate_<language>_<locale>.properties is present in
the <INSTALL_DIR>/installed_data/smcfs/components/complete_installation/
factorysetup/XMLS directory.

2. Execute the following command from the <INSTALL_DIR>/bin folder:
For Windows: sci_ant.cmd -f localizedstringreconciler.xml import
-Dsrc=<INSTALL_DIR>\installed_data\smcfs\components\
complete_installation\factorysetup\XMLS
-Dbasefilename=sbifcliterals2translate

For UNIX or Linux: sci_ant.sh -f localizedstringreconciler.xml import
-Dsrc=<INSTALL_DIR>/installed_data/smcfs/components/
complete_installation/factorysetup/XMLS
-Dbasefilename=sbifcliterals2translate
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi

Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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